


THE NATIONAL ANTHEM

Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga
Tava subha name jage,

Tava subha asisa mage,
Gahe tava jaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,
Jaya he, jaya he, jaya he,

Jaya jaya jaya jaya he!

PLEDGE

India is my country. All Indians are my
brothers and sisters.

I love my country, and I am proud of its rich
and varied heritage. I shall always strive to
be worthy of it.

I shall give my parents, teachers and all elders
respect, and treat everyone with courtesy.

To my country and my people, I pledge my

devotion. In their well-being and prosperity
alone lies my happiness.
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FOREWORD

Dear Learners,

The world around us is changing fast. The borderlines that
were created by time and distance are fading away. The infinite
potentials of Information and Communications Technology made
so many things possible which were considered impossible. This
is the era in which our classrooms are rapidly transforming into
smart rooms with multimedia facilities, as a result of new
technology. Intune with these changes, the contents in this textbook
are developed to enable you to move towards the world of
technology, to promote self-study and to construct new knowledge.

Each and every activity included in this textbook is prepared
by assimilating the contexts in similar lessons from other
subjects. It will be helpful for the study of those lessons.

The lessons are designed in such a way that practical work
is given prime emphasis. | sincerely believe that you will be
able to do and practise all learning activities given in this
textbook, and make use of those acquired skills in the study of
other subjects as well.

Dr. J Prasad
Director
SCERT
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CONSTITUTION OF INDIA
Part IV A

FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A

Fundamental Duties- It shall be the duty of every citizen of India:

(@)

(b)

(©
(d)
(€)

(f)
)
(h)

()
()

()

to abide by the Constitution and respect itsidealsand institutions,
the National Flag and the National Anthem;

to cherish and follow the nobleidealswhich inspired our national struggle
for freedom;

to uphold and protect the sovereignty, unity and integrity of India;
to defend the country and render national servicewhen caled uponto do so;

to promote harmony and the spirit of common brotherhood amongst all the
people of Indiatranscending religious, linguistic and regional or sectional
diversities; to renounce practices derogatory to the dignity of women;

to value and preservetherich heritage of our composite culture;

to protect and improvethe natural environment including forests, lakes, rivers,
wild lifeand to have compassion for living creatures;

to devel op the scientific temper, humanism and the pirit of inquiry and reform;
to safeguard public property and to abjure violence;

to strivetowardsexcellencein all spheresof individual and collectiveactivity
so that the nation constantly rises to higher levels of endeavour and
achievements,

whoisaparent or guardian to provide opportunitiesfor educationto hischild or,
asthe case may be, ward between age of six and fourteen years.
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lWhen A Letter Reaches the Computer

With the passage of time, stone moulds which were
used for printing gave way to metal moulds. Later these
moulds also went out of use. Nowadays, the contents of
a book are typed and arranged (layout) with the help of
computers.

Have a look at the extract from a page of your
English Reader given below (Fig. 1.1). How would this
have been prepared? Definitely, with the help of a
computer. This is exactly what we are going to learn in
this chapter - how to prepare a page like this with the
help of a computer.

The Recuyell of the Historyes of Troye

William Caxton was the first Englishman who learned
to use a printing press. The Recuyell of the Historyes of
Troye was the first book he printed and this was the first
ever book printed in English. It was produced in 1473
either in Bruges or Ghent in the European Continent.
The book by Raoul Lefévre is a recuyell (compilation) of
stories about the Trojan War, originally written in
French. Caxton himself translated the book.

British Library - Learning English; Timeline
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When A Letter Reaches the Computer

Fig.1.1 Tagore’s poem - Taj Mahal
Text entry

This page contains text and images. How can we
input a text into the computer? Which hardware do we
make use of for this purpose?

It is the keyboard which is familiar to us that we
use for this. The manner in which the letters of the
alaphabet are arranged in a keyboard is called Keyboard
Layout. Look at Fig.1.2 and examine the layout of an
English keyboard.

Typewriter

Have you ever seen a machine like this? This is a
typewriter which was used in earlier days for typing.
As computer became popular these machines are no
longer in use.




When A Letter Reaches the Computer

Fig.1.2 English keyboard layout

Have you noticed a mark on the keys ‘F" and ‘]’ on
the keyboard (see Fig. 1.2)? We must position our index
finger of both the hands on these keys and then the other
tingers on the subsequent keys accordingly. Now, move
your fingers to the top and bottom rows to find out
which keys can be typed using each finger. You might
have to stretch your fingers to type some keys in the
other rows.

You can see that you will have to use your index
finger and little finger of both hands to type more keys
arranged in all rows of the keyboard. Refer Fig. 1.2 and
identify the keys to be typed using each finger.

Practice typing

To type quickly and accurately is a
skill one has to acquire through
practice. There are various software
that help us to learn typing in a
scientific way. KTouch, Tux Typing,
etc. are examples of typing tutor
software. Test your typing speed using
the KTouch typing tutor installed in a
computer. One must be able to type at
least 40 words (200 characters) per
minute without mistakes.

Fig.1.3 KTouch window

Information & Communications Technology - VIII = 9



When A Letter Reaches the Computer

Information in the form of letters

We have learned to type letters, numbers and B3l finger not too
symbols using a keyboard. What are the occasions where little!
we need to type letters, words and sentences?

How many letters are

¢ To draft letters there which are to be

¢ To prepare articles typed using the right
hand little finger? List

¢ To prepare documents them down. You can see

R that your little finger is not
that little!

Here we want to type a poem in a computer. What
should we do?

¢ Type the words of the poem. If mistakes occured
during typing, we have to correct them.

¢ If some words are found inappropriate, we will have
to replace them with some other words.

¢ If you have to replace a particular word or a name
with another in an article containing 500 pages, what
will you do?

¢ Youmay sometimes find sentences misplaced. How Text

will you place them correctly? _ ) .
The information given as

¢ Headings and letters can be made attractive by input to a computer in the

giving colours. form of characters, is

. technically known as text.
.................................................................................................. The characters like letters,
numbers and symbols
that we have already

typed can also be called
Likewise there are a number of things that we have  text. The major device

to do while using a computer. There are various options  used to input text is a
in our computer that help us to do these activities. keyboard.

Word processor

There are numerous software which help us to
prepare or process the text that we input into a computer
in the way we wish to. See Table 1.1.

10 Information & Communications Technology-VIII



When A Letter Reaches the Computer

Software Software developed by
LibreOffice Writer The Document Foundation
Microsoft Word Microsoft Corporation

Appache OpenOffice Writer Appache Software Foundation

Abi Word

Abi Source Project

The software listed in the above table are generally
called word processors. Identify which of these software
are there in your computer.

How can you open the software LibreOffice Writer
installed in your computer?

Activity 1.1 - Let’s type a poem

Using the keyboard of your computer type the lines
given below in LibreOffice Writer.

Taj Mahal

Taj Mahal is considered as one of the seven wonders of
the world. It is a work of art that excels time and history.
The following lines are from Tagore’s poem ‘Shah Jahan'.
In this poem Tagore speaks of the immortal creation,
the Taj Mahal and the timeless appeal of that great
monument.

You knew, Emperor of India, Shah Jahan,
That life, youth, wealth, renown

All float away down the stream of time.
Your only dream

Was to preserve forever your heart’s pain.
The harsh thunder of imperial power
Would fade into sleep

Like a sunset’s crimson splendour,

But it was your hope

Information & Communications Technology - VIII | 171



When A Letter Reaches the Computer

That at least a single, eternally-heaved sigh would stay
To grieve the sky.

While typing these lines, leave a space after each
word and when we complete a sentence, don’t forget to
put a full stop mark and a space.

We know that when the text reaches the end of a
line, it automatically goes to the next line. To start a new
paragraph, press the Enter key. If we want to go to next
line - not as a new paragraph - without completing the
previous line (it often happens when we type poems),
hold the Shift key and press the Enter key.

Other input methods

There are many people around us who are not able to type using a keyboard.
Similarly, there are some who cannot read the text displayed on the computer
screen. Won't they have the need to use computers? How is it possible for
them to use a computer? There are various ways to help such people to input
text and read the matter displayed on the screen.

Text from books

The matter from a book can either be identified and read or converted to a text
tile in a computer using various software. Normally it is done in the following
way :

B Take an image of the page using scanner and save it in the computer.

B The next step is to identify the characters in the image and change them to
a text format, like the one we get while typing using a keyboard. There are
software which can do this work very well. They are called OCR (Optical
Character Recognition) software. LIOS available in our system is one such
software. It works based on the OCR software like CUNEIFORM and
TESSERACT.

B Software that converts handwritten words on the screen of our mobile
phone, into text is very common these days. This is also an example of a
software which identifies letter forms and converts them to text.

12 Information & Communications Technology-VIII



When A Letter Reaches the Computer

B Such afile which contains the data so converted can be used as an ordinary
text file.

Text from speech

Identifying the words of our speech, converting them to text and feeding them
into a computer (Speech to text) is another method.

Such text input is done as follows :
Input our voice into the computer using a microphone.

Convert the audio data that has been input in the computer into a text with
the help of software. Sphynx, Julius, Simon, etc. are such speech recognition
software for English. Find out if there are any such software for Malayalam.

Fig.1.4 Differentinput methods

Text editing

It is natural to make mistakes while typing. How
do we correct them? Should we do the correction while
typing itself?

¢ Notice the vertical blinking black line in the software
window that moves as we type. This is called the
cursor. Cursor denotes the position of the text that
we are typing. We can place the cursor anywhere in
the text by clicking the mouse on that place (we can
also use the arrow keys on the keyboard).

¢ It is better to make the correction after typing the
whole matter. This will save time.

Information & Communications Technology - VIII = 13



When A Letter Reaches the Computer

¢ If we find mistakes after typing the matter, what will
we do? Place the cursor on the incorrect word. Use
the Backspace key to delete the letter on the left of
the cursor (before the cursor). To delete the letter
on the right of the cursor (after the cursor) use the
Delete key. Then, type the correct letter.

¢ A dictionary is included in the word processor
software. Each word that we type in is verified with
this dictionary. When a word which has not been
included in the dictionary is typed, it will be
underlined automatically. Right click the mouse on
the underlined word. What do you see in the menu?

¢ Imagine that we have misspelt a word and we are
not sure of the correct spelling. What will we do
now?

B Right click the mouse on the word.

¢ If the word is not in the dictionary and if we don’t
want to add it, what is to be done?

While dealing with more than one window

Fig. 1.5 shows the Desktop of a
computer (Operating system). The
rectangular regions seen on the right
hand bottom indicate different
workspaces.

Let’s open one window in the first

workspace. Examine whether it is

visible when we switch over to the

second workspace. This is an Fig.1.5 Desktop and Workspace
efficient system when we have to

deal simultaneously with more than one window. We can open different software
in each workspace, if needed. We can also transfer or share data between
windows that are opened.

14 Information & Communications Technology-VIII



QWERTY
Keyboard

Examine a keyboard
in detail. We can see
that the letters are
arranged in 3 rows.
The first few letters
towards the left in the
first row are
Q,W,E,R,T,Y.
Therefore, this
keyboard layout is
called ‘QWERTY
Layout’.

Death by
comma

Make sure to type the
symbols in appro-
priate position. See
what happens other
wise.

When A Letter Reaches the Computer

Let’s copy from one file to another

At present we are on the first workspace. Now, click
on the second workspace and open the Home folder.
Here you can see School_Resources folder in which you
can see a file Taj in the Std VIII folder. You have observed
the poem that is typed in, haven’t you? You may copy
the required lines and paste it in your page. How can
we do it?

¢ Select the required lines: Place the cursor before the
first letter of the text to be copied. Then, click and
hold the left button of the mouse and move the
pointer to the last letter. This process is called click
and drag.

¢ Copy the selected part : Click the shortcut tool &

you see in the tool bar or click on Copy seen in the
Edit menu.

¢ Now, let’s go back to the window that was left open
in the first workspace. Here, we can see the file that
was opened earlier. Now, paste the copied text in
the required position.

Did you notice Paste in the Edit menu when you
opened it for copying? Now, how can you paste the
copied text?

One can also see Cut in the Edit menu. What
happens if you Cut and Paste instead of Copy and
Paste? What difference do you notice?

Activity 1.2 - Let’s copy a file

From the given file Taj, copy the second paragraph
and paste it into your file. Write down in your notebook
the process you followed.

Information & Communications Technology - VIII | 15
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Let’s save

Now, we have completed typing the poem. Let’s
store this before we proceed. We generally come across
instances where we have to reuse the work done
previously by us in a computer. For this, we have to store
such files. This process is called ‘saving’. How do we
save this page?

Folders and sub folders

Each and every work we do in a computer is saved as a file. Thus we will
have a number of files on the various works we have done. It is important to
arrange and save these files properly for future use. It can be done with the help
of Folders. We can create a folder as follows:

¢ Place the mouse pointer on the empty space where you want to create a folder.
¢ Right click the mouse.
¢ Then select New Folder.

¢ Name the folder in the new window
and click Create.

¢ The folder is ready now.

In the same way one can also make sub
folders (folders within a folder). This helps
us to categorise and save different files on
the same toFig. Refer Fig.1.6. Create a
folder, Students_ Works_8 in the Home
folder. Inside this folder, create a folder by
the name of your class and a folder named
Docs.

Now, let’s try to save the file that we were working
with. We can do this by clicking on the tool in the
LibreOffice Writer window. We can see our folders listed
on the right side in the window that pops up (Refer
Fig.1.6).

Then, place the mouse pointer on the required
folder and double click on it. Likewise, by double

16 Information & Communications Technology-VIII



When A Letter Reaches the Computer

clicking on the folder, you can open your class folder
and other sub folders.

To save a file:

First, decide where to save the file. Here, we have
to save the file in the sub folder Docs in the class folder
in Students_Works_8 which is present in the Home
folder.

If we want to save on the Desktop, refer to Fig.1.6
and identify the icon to be clicked. (Desktop is where
we open all the software windows. It is not a good
practice to save files on the Desktop.)

This is the home folder.

Home is the place where

the files of the user are
stored.

Open this to save in the
Desktop .

Fig.1.6 Window to save file

What should be the name of the file to be saved?
We save files to use them at a later time. So, when we
name a file, it would be better to name it based on the
content. It would be better to name the file using a single
word. Shall we name this file Taj_Mahal?

Now, click on the Save button.

Let’s beautify the characters

Wehave added all the lines of the poem in our page.
Does the computer understand that this is the heading?

For this, select the sentence. And from the Style box
in the tool bar, choose Headingl. Observe what changes
happen to the heading.

NT-473-2-ICT-8-E-VOL.1
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When A Letter Reaches the Computer

See how we can make the heading attractive?

Colour : Blue
Size : 30

Style : Bold
Font : Free Sans

See some of the tools that we can make use of in
LibreOffice Writer.

Fig.1.7 LibreOffice Writer window

Which tools are to be selected for the above
activities? Fill in the table below.

Character [ What/How much?, How to do?
Colour Blue

Size

Style

Font

Activity 1.3 - Paragraph formatting

We have already discussed how to split the input
text into different paragraphs. Paragraph Formatting
helps us to:

A few English
fonts
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adjust the spacing between lines.
adjust the spacing before and after a paragraph.

give borders

* & o o

give background colours, designs etc. and make
our text attractive

Select the text in a paragraph. Then click on
Paragraph in the Format menu.

The window that opens is given in the picture below.
You can give the required measurement in the boxes
you see here.

Fig.1.8 Paragraph formatting window

Refer to the picture and identify how to make the
changes required and fill in the columns in the table
overleaf.

Activity Required How to make the change
change
Border of the first Above & | Select the first paragraph. Select Borders in
paragraph Below Format - Paragraph window. Click on the [ ]
icon to give a border to the paragraph.
Colour of the
border Blue
The spacing of the
second paragraph
from the left

margin. This is
called indent.
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Spacing above
each paragraph

Spacing below
each paragraph

Spacing between
lines

Inserting pictures

Single

Certain pictures are stored in the Images folder in
the School_Resources folder in the Home of your
computer. Identify the pictures we need to use in our
page. These pictures can be included. Identify the tool
used to insert images from Fig.1.7. Click on this tool and
find out what happens.

In the Image folder of School_Resources, there is a
picture named TajAndTears.jpg. How can we include
this picture in our page? Note down the steps.

¢ Select TajAndTears.jpg and click Open.

Save again

The file that we are working with was saved earlier.
But we have made some changes in this file after saving
it. Will these changes automatically be saved in the
previous file?

Where will T go?

No, we have to save it again. But now what happens
when the tool/icon is clicked? Can we explain why
the window that asks where to save the file and with
what name, doesn’t appear?

If you have to save the same file within a different
name, what will you do?
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Arrange the text in your file into paragraphs as in
Table 1.3. Include pictures and make the characters
attractive. Do not forget to save your file.

Using only the keyboard...

Some tasks can be done with the keyboard alone. We had earlier done the
Copy-Paste activity using the Edit menu. Let’s examine this once again.

¢ Select the text to be copied.

¢ DPress and hold the Ctrl key and then press C to copy the text.

¢ Press and hold the Ctrl key and then press V to paste it.

Certain shortcuts are listed below. Complete the table below.

Activity Shortcut Activity Shortcut
To copy Ctrl + C To save
To cut To find a word in the

text

To paste the
matter that has
been cut or
copied

To make the selected
text bold.

Fig.1.9 Printer

Out from the computer

The data taken out from a computer is called ‘out-
put’. What would be the output of the text that we have
processed?

¢ While working with the text, we can see the display
on the monitor. Therefore, the monitor is an output
device.

¢ If we print this file, it is also an output. So, printer is
a device to output our data.

¢ The file that we have saved itself is an output. It can

Information & Communications Technology - VIII | 2]
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be stored in devices like CD (Compact Disc),
or pendrive, or it can be sent as an email to
another person.

Activity 1.4 - Machine reading

Open the file that we have saved earlier. Copy
the text in it. Now, open the Gespeaker Software
in your computer (Applications — Sound and
Video — Gespeaker). Paste the copied text in this
window and play it (Refer to Fig.1.10)

What form of output is received from the text
now?

........................................................................................

(Don’t forget to connect the speakers.)

Fig.1.10 GSpeaker Window

1. Some computer accessories are listed below. Which
of them are used for text input?

a) Keyboard
b) Speaker
¢) Scanner
d) Camera

2. Which of the following is true about the question:
What are workspaces used for?

a) To copy and paste a content from one file to
another.

b) To cut and paste a text to another file.

c) To operate more than one window
simultaneously.

d) To open various software at the same time.




When A Letter Reaches the Computer

3. When should we save a file we are working with?

a) After all the work with the file is over and when
we are about to close it.

b) As soon as we open the software and start our
work and then frequently save while working
on it.

- Extended activities
1. Look at the nursery rhyme given below:

There was a tree
The cutest little tree you ever did see

The tree was on the valley

Can you guess what the next
line of the song would be?
And green grass grew Complete the poem by typing
And green grass grew around. necessary lines and copy-paste
the lines that are repeated.
Replace the word ‘green” with the
The branch was on the tree word ‘blue’ in the text using ‘Find

The cutest little tree you ever did see and Replace’.

And green grass grew

There was a branch

The tree was on the valley
And green grass grew
And green grass grew

And green grass grew around.

2. To copy a portion of a text from the word processor, we usually select
the text by dragging the mouse from the beginning to the end of the text.
There are some other ways also to select a text. Place the cursor on the
text and do the activities given below and complete the table.

Activity Result

One mouse click No change in the position of the cursor.

Double click the mouse

Click the mouse continuously
for three times
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There are different ways to copy a portion of the text in a page and paste
it elsewhere. You can use whichever method you are familiar with.

Now, select the text to be copied and click the right button of the mouse
on it. What are the steps to be followed? Write them down.




‘ The Wonderland of Pictures

Hari happened to see an old family photo of his, while he was searching for a
book last day. The photo attracted him very much. He desired to crop his
childhood photo from it.

Don’t such situations occur at times? Have you ever
felt the need to crop a photo of yours and resize it with
the help of a computer? This unit will help you to solve
such issues.

There is a project ‘Earth and Man’ in the unit ‘In
Search of Earth Secrets’ in your Social Science textbook.
You have to collect pictures, crop the relevant parts and
resize some of them and include them while preparing
the project in the computer. How can you collect the
required pictures? There are several methods by which
you can do it.

Activity 2.1 - Let’s get a picture

¢ Capture a photo using a digital camera and copy it
in the computer.

¢ Scana picture from a book or a newspaper and save
it in your computer.

¢ Draw the picture in the computer.

Discuss and prepare a write-up on the various
methods of preparing digital pictures.

Information and communications Technology-VIII 25
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The Wonderland of Pictures

Certain pictures that can be used in projects are
included in the ‘Image_editing’ folder in
‘School_Resources’ for Std. VIII. Open the folder and
double click on one of the pictures. Did the picture
open? It must have opened in Image Viewer software.

What must be done to view the next picture in this
folder? Should we have to close the current picture for
that? Check by pressing the right arrow key in the
keyboard. Is there any other option for this? Find out.

¢ We can zoom the picture.

¢ Makeitrotate (Place the mouse pointer at the bottom
of image).

Watch the picture (Fig.2.1) opened in the Image
Viwer. Have you noticed the Properties window in the
picture? The size (measurement) of the picture is given.
It shows 1628 x 1083 pixels. (If the Properties window

doesn’t appear, click E] in the titlebar and tick the Side

pane). Often it is essential to have knowledge about
the measurements (dimensions) while handling pictures
in computer.

Fig.2.1- A picture opened in Image Viewer

Imagine that you have to cut the portion of the
ploughed soil, bullocks and the plough man from the
picture, to use it in the project work. We have to reduce
the size of the picture too. How can we do these
activities? There are a good number of software available
in our computer to perform the above mentioned tasks.

/////////////////////////////////////////////////////////////////////
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GIMP (GNU Image
Manipulation
Program)

GIMP is a graphic
editor software used
for editing digital
pictures and
photographs. This
free software was
released in 1996. In
the beginning it was
known as ‘General
Image Manipulation
Program’. Spencer
Kimball and Peter
Mattis, two research
scholars of California
University, started
GIMP as a research
project. It became a
part of GNU Project
in 1997 and was
renamed as ‘GNU
Image Manipulation
Program’.

The Wonderland of Pictures

¢ GIMP

¢ Inkscape
¢ XPaint

¢ MyPaint
¢ Pencil

These are some of such software. Open each of them
and see how it works.

Let’s perform the above said activities using GIMP.
First, open an image in GIMP.

Activity 2.2 - Let’s open a picture in GIMP

Open GIMP and click ‘Open’ in File menu. Pictures
can also be opened in GIMP by right clicking on the
picture and selecting GNU Image Manipulation Program
from ‘Open with other Application’.

Now, let’s cut the parts of the picture we need to
use in the project. If we edit and save the picture opened
in GIMP, the original picture will be lost. To avoid this
let’s make a duplicate of the picture and do the editing
on it.

Activity 2.3 - Let’s prepare a duplicate image

Click on ‘Duplicate’ in the Image menu. Press and
hold ‘Ctrl” and then press ‘D’ on the keyboard. How can
we identify the original picture from the duplicate one?
“Untitled” will be displayed in the title bar of the duplicate
image. The changes made in the duplicate image will
not affect the original image.
Activity 2.4 - Let’s edit an image

Let’s cut the part of the image we need. How can
we cut an image using the Crop Tool ?

¢ Select the Crop Tool.

¢ Drag the mouse and mark the part we need to cut.

¢ DPress the ENTER key in the keyboard.

Information and communications Technology-VIII 27
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The Wonderland of Pictures

Did you get the part of the picture you needed?

Fig.2.2 - GIMP toolbox

Activity 2.5 - Let’s resize an image

Facilities for resizing an image are available in
GIMP. To resize an image:

¢ Select Scale Image from Image menu.
¢ Enter the width and height in the columns provided.

The height will be automatically adjusted according
to the width. (There is a Link which links the height and
the width.) Then click on the Scale button. The size will
be changed. How can we fix the width and the height as
we like? Click on the ‘Link’. It becomes ‘Unlinked’ . Now,
you can arrange the width and the height as you like.

Now, let’s save the image we have edited. Where
can it be saved? You have already made a folder in your
class folder in ‘"Home’, haven’t you? Open it and make
another folder named ‘Images’ in it. Save this image in
it. Don’t forget to name the file.

/////////////////////////////////////////////////////////////////////
Information and communications Technology-VIII

How can I open
pictures in

GIMP?



The Wonderland of Pictures

I don't need
the full image.

Fig. 2.3 - Scale Image window
Activity 2.6 - Let’s identify file formats

Let’s analyse the files saved in the folder. You can
see the extension .xcf after the file names you have given.
This is to indicate the type of the file. .xcf is the indication
of a file created in GIMP.

How can I reduce the

size of this picture to

include it in the projec
?

Activity 2.7 - Let’s export an image created in GIMP

O Open an image created in GIMP. Does it open in

o Image Viewer like the other images? It's opened in
GIMP itself. Why is it so? It's only a project file. It can be
used only when it is converted into an image format.
‘Export’ is used to change a file from one format to
another and save it. How can we export a file?

¢ Click ‘Export As’ from File Menu.
¢ Choose the location to save the file.
¢ Name the file.

¢ Click on’Select File Type’ and choose the file type,
i.,e.,, PNG image, JPEG image, TIFF image etc.
Now, you can see file extension after the file
name.
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¢ Click on the “Export’ button.

Analyse different types of files in your computer
and identify their file formats. There are different files
in the folder “Examples’ in “School_Resources’ folder for
Std. VIIL. Don’t you see file formats in each of these files?
Open each of them and identify the file types.

Identify the file formats given below and complete
the table. (Table 2.1)

File formats: jpg, mp3, png, wav, mp4, ods, odt, mpg,
avi

File Format

Image

Sound

Video

Spreadsheet

Word processor

Table 2.1 : File and format

You have already collected the pictures to be
included in the project report. Now, let’s prepare a cover
page for your project report. (Fig.2.4)

Project file

It may not be possible for us to complete all the editing
of a picture at a stretch using the GIMP software. We
will have to open the file many times and make

necessary changes. Hence we keep them as Project Wilber

File. We will export them as picture, only when all ~ Wilber is the official
the editing works on it are finished. When we edit =~ mascot of GIMP.
videos using video editing software, we keep them This was created by
as Project Files. We can continue editing only when T u o m a s

Kuosmanen from

the file is saved as Project File.
Finland.
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Fig.2.4 Cover page
Activity 2.8 - Let’s prepare a cover page

Open GIMP first and make a new canvas. How
can we make a new canvas in GIMP? Do the
following activities.

¢ Click on the ‘New’ button in the ‘File’ menu.

¢ You will get a new window. Here you can select
the template you like. You can also set the canvas
by typing the required width and height. (We
prepared the project report in A4 format.
Therefore you can select A4 from the templates
given to prepare the cover page).

¢ C(Click on the OK button.
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Now, you have got a new canvas. It’s time to give
background colour to it. As shown in the picture (Fig.2.4)

you can mix colours using Blend Tool to make the

background more attractive and colourful.

Give colour to background

¢ Click on ‘Foreground & background colors’ -..%
and select suitable colours from it. "

¢ Select Blend Tool.

¢ Click on the canvas and drag.

You have got the background coloured. Now, click
on different points in the canvas and drag. What changes
can you see? You can see the background coloured in
different ways.

If you want to give a single colour to the

background, you can use ‘Bucket Fill’ tool

Add a text

Text Tool can be used to add text. Click on the

‘Text tool” button. Select a suitable font, font size and
font colour from the ‘“Tool Options’ (Fig.2.5) menu.

Click on the canvas and type the text you need to

add. “‘Mowve Tool’

text in its original position. Click on the ‘Move Tool’
button and then on the typed text. Then, drag the mouse
pointer. Did you feel any difficulty to re-arrange the text?
You can re-arrange the text when the mouse pointer

can be used to arrange the typed

touches the text. A mark appears on it. If you click

and drag the text, it can be moved.Type the text and
arrange it in proper positions.

Draw a picture

Shall we draw a picture and add it in the cover page

(Fig.2.4) ‘Paintbrush Tool’ can be used for this
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purpose. Select the suitable colour from ‘Foreground

& background colors’ E Click on the ‘Tool

Options’” button and adjust the size of the brush you
need. Now, draw and add a picture and make the
cover page more beautiful.

Try to draw a straight line using the ‘Brush
Tool’. Don’t you feel a little difficulty to do this?
Press the Shift key in the keyboard and try the ‘Brush
Tool” again. Is it easy now?

Fig. 2.5 Tool Options window A ctjity 2.9 - Let’s make the heading more

attractive

Attractive titles can be prepared with the help of
‘Logo” in GIMP. Let’s see how a title can be
prepared.

¢ C(Click on File - Create — Logos

¢ Select the Logos type you like.

I need an
attractive title for
my project report

¢ Type the title in the window and click on the OK
button (Fig.2.6).

Fig.2.6-Logo window

You have prepared an attractive title. Export this
title and convert it into a picture. You will learn how to
use logo in GIMP, in the higher classes.
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Activity 2.10 - Let’s prepare a screenshot

Screenshot facility is used to save everything you

see on the screen, as a picture. How can we do this? I've captured a scenery

using my camera. How
¢ Display on the screen the portions we need to | can I capture a picture

screenshot. from my computer
screen?
¢ Press the Print screen key (PrtSc) on the
keyboard. \

Didn’t you get the screenshot? Now, save it. When
you are making a screenshot, you get the picture of
everything on the screen. If you want to get the
screenshot of a window opened exclusively, press Alt
key and PrtSc key together.

There are many other ways to prepare screenshots.
We can make screenshots using GIMP software also.
Using GIMP, it is easy to select a particular part of the
screen and take the screenshot.

¢ Open GIMP and select screenshot from ‘Create’ in
‘File’ menu.

¢ Give necessary details in the window opened
(Fig.2.7). (Whether to include the full screen or a
particular portion, a window or a particular portion
of a window, whether mouse pointer to be included,
time of capturing etc).

¢ Click on “‘Snap’ button.

¢ If you have to capture a particular portion of the
screen, click and drag to mark the part on the screen.

¢ Save the screenshot.

Screenshots can also be created using ‘Screenshot’,
‘Spectacle’, etc available in the Accessories menu in the
computer. Take screenshots using these facilities and
save them.

Photo editing in mobile phones

Photo editing can be done in mobile phones also.
Different facilities to resize a photo, crop it and add text
to it are available in smart phones. Photo editing
softwares for smart phones are easily available today.
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Fig.2.7 - Screenshot window

1. Which shortcut method is suitable for making the
duplicate of a picture opened in GIMP?

a) Ctrl +A
b) Ctrl + B
c) Ctrl + C
d) Ctrl + D
2. Which tool is used in GIMP to cut a part of a picture?
a) Clone Tool
b) Move Tool

c) Crop Tool

d) Brush Tool
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3. Match the following

File File Format
Picture file odp

Movie file mp3
Spreadsheet file irg
Presentation file mp4

Audio file odt

Word Processor file ods

1.

- Extended activities

Prepare alogo ‘Keep Your Footwear Outside” in GIMP to paste it outside
the school computer lab and export it.

. Download a picture suitable for making a new year greeting card from

the internet, with the help of your teacher. Open the picture in GIMP
and crop the part you need. Resize and export it.

. Open the ‘Logo” window in GIMP. Take its screenshot using Spactacle

and save it.

/////////////////////////////////////////////////////////////////////
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(ETOCYU)]C!]E’.HD,] - @0
om20moe, qU
g alglam
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o “mopjaem)

Sim" ” oMo al

oqae.

‘26mIMoB0 @aI0@3 BW)00 M22YHS
2e1m5108 ©20¢] 2LIWIs0"

These lines are composed by the famous poet
Sri O N V Kurup about the beauty of our language.
Can we type this in Malayalam and store it in our
computer? Some of us write stories or poems in
Malayalam. How is it possible to save them in
computers?

This is an extract from the Malayalam
dictionary ‘Shabdatharavaly” (wwenizmonoar
eil) which was printed using metallic type
foundry. In olden days, printing books in
Malayalam was extremely difficult. There
are over 500 different combinations of
letters and symbols in Malayalam. Each of
them needed separate moulds. Arranging
these moulds to form the text was also not
an easy task. Imagine the difficulty if a
particular letter cluster appears many times
in a page! For example “»s’. Think of the
trouble of including the word * wyagisaydmad’
many times in a page! The task is not that
easy...!
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Let’s type in Malayalam

Normally, when we type using a keyboard, we find
English letters on the computer. How can we change
the keyboard layout to type Malayalam letters? Refer
to Fig.3.1.

Fig. 3.1 Dropdown menu of En icon

¢ C(lick on the icon that is seen on the top right
position on the Desktop.

¢ Choose Malayalam from the drop down menu.

Now, the keyboard is ready to input Malayalam
letters.

Open the word processor and try to type the poem
given above. Can you do it easily and accurately? In
order to type fast, we should have a knowledge about
the Malayalam keyboard layout.

Inscript key layout

The order in which keys are arranged in a keyboard
is called keyboard layout. This is based on the nature of
the language and the flexibility of our fingers. Fig.3.2
shows the Inscript Key layout developed by C-DAC, a
central government agency for typing various Indian
languages.

Refer to the picture and observe the layout. What
are your findings?

The letters in Malayalam can broadly be classified
into two - Vowels (amiooesoesuwd) and Consonants
(UL RMOHO6BBUD).
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Left Hand Right Hand

Fig. 3.2 Keyboard layout

The keys are arranged in such a manner that all the
vowels (except ‘gg’) are typed using the left hand.

Most of the consonants are typed using the right
hand.

Now, position your fingers correctly, as explained
in the first unit and complete the following table.

Finger Normally
When Shift key is pressed
, & »
Right hand, Middle finger
oy &l ogl
Right hand, Ring finger
Right hand, Little finger
Right hand, Little finger extended
av © a0
Right hand, Index finger
0 0 6B
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Right hand, Index finger extended

Left hand, Middle finger

Left hand, Index finger

Left hand, Index finger extended

Left hand, Ring finger

Left hand, Little finger

Left hand, Litter finger extended

Thumb

Space bar

Table 3.1 Fingering

Study the table given below and understand how
combinations are made to form different letters.

Y 2 = & S - )
) ® ) &H S ™ D> am
a6 —> GIVI ™ ¢ @ 2> o®
™ AN —> M n S o = o

Table 3.2 Combination of letters and symbols




Desktop Dictionary

Sometimes we find it
difficult to understand the
meaning of some words.
Usually in such circum-
stances, we seek the help
of a dictionary.

A dictionary named
Theeram is installed in
your computer which
gives meanings and
usages of words. It gives
the English meaning of a
Malayalam word or the
Malayalam meaning of an
English word.

Fig.3.3

Fig. 3.3 Theeram in Dictionary

Can You Type ‘@pan’ In the Computer?

Activity 3.1 Lets type the words

Type the words give below. Make sure the
keyboard layout is Malayalam.

® HO, MS, &S, al®, MO, aldD

¢ B0, 21l0)®, alSO)d, Cal®)d, GalO®]

¢ Mlmo0, dle:al, &alel, &S)al, mamlmo

¢  @POEI, @RQ, DA, DS, SA, OV, B0)A, BOS)d>
¢ 8Y0, &101S0, alj)2, al)al, OS], GO, HOHMROQI
¢ H0HH, VIO, NBENM@D], 2I(B&HIAM0, TVDMBOY0

¢ lOMIO, alBH0Wo, MVEINEG], lBlUoR0, @RYaQOB0

¢ 33360, Q3®), a6, al0Q, af)o0g, ®EMSo

Don’t forget to save the file. In which language
are you going to name the file?

Let’s now type some more words. For
example @paid, aemdalo(@o etc.

There are special keys to type
chillaksharangal. See the table given below :

Try to type more words :

@RAING, @PAIA, @RAIUS, MEMald®, QlT3al(@o
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To type maoet? How is it when you type
aWetlafelolellvolcHd

These are not Malayalam words. The letters should
not be combined as the combination letters in
Malayalam. To make these letters stand apart, we make

use of another key

Thus,
Mad 21— quadel
cgm)omj’g}’ 00IVAa — cgcmom”g}’s)mmxa

The KTouch software that we used as English
typing tutor can be used for learning Malayalam typing
too. Open this software after changing the keyboard
layout to Malayalam. We get the lessons to practise
Malayalam typing. Seek the help of your teacher to learn
how new lessons can be included for practice in this
software.

)E0IM)0)MNU)o  &)FIWIMW)o

\bpw

Other Desktop
Dictionaries

There are two other
dictionaries namely
Golden Dict and
Artha which helps us
to find the meanings
& usages of English
words.

Golden Dict is a
multilingual dictio-
nary. It gives us the
English, Malayalam,
Hindi and Urdu
meaning of a word.

Activity 3.2 Let’s type a poem

Type this poem in word processor.

Give the heading ‘®»,)eommyoymio
s)sloomw)o’. Also insert a picture.
Select the lines of the poem and
change the font to ‘Raghu

Malayalam’.

We have already learnt how to
make changes in a text according
to our requirement. Set the page as

given here.

ASCII and Unicode

The letters and symbols that we input to a computer have to be converted to
a format that can be understood by the computer. This process is called
‘encoding’. Initially, this encoding could be done only for 256 characters

including the letters and some symbols.
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This encoding is called ASCII (American Standard Code for Information
Interchange).

Under such circumstances it was not possible to use the letters of other
languages like Malayalam. To overcome this difficulty, a solution was to convert
English letters to Malayalam using a software. ISM developed by C-DAC is one
such software. Though the font is visible as Malayalam letters, it is being encoded
as English letters. This was a drawback of this software. It was difficult to search
and find out a certain word from the input data.

As technology advanced, this problem was also solved. Unicode technique,
which helps us to encode more characters, came into use from 1996. Thus
Malayalam also found its place in the encoding technique. The letters and fonts
of Malayalam could thus directly be input into the computer. This was a drastic
change for Non-English languages.

Thus we can:
¢ Type Malayalam words in Malayalam font itself.

¢ Malayalam words can be used in the internet. Browse the web using
Malayalam words.

¢ Include information in data banks like Aadhar, Voters list etc. in Malayalam.
You can search and find names and other details from these data banks.

¢ If relevant software and font is available, the files created in one computer
can be opened and read on other computers, tablet PCs or even on mobile
phones.

¢ Texts can be read using machine. A text written in one language can be
translated to another language using software.

Reading text using machine

If we input a text in a language other than
English, we can hear it with the help of a
software, provided the speaker is connected.
How can we do this? Copy the poem typed
earlier and paste it in Gespeaker software.
Adjust the speed and pitch of the output and
click the “play” button. One can listen to how
the software reads the text. Those who have
visual problems and are not able to read from

the monitor will surely find this software a
blessing. Fig. 3.4 Text in Gespeaker window
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Malayalam fonts

The style of writing of each person is different from
that of another. The style of letters used in a computer
is called font. For example, some common fonts of
English alphabet are Liberation Serif, Liberation Sans
etc. Similarly there are various fonts in Malayalam too.
Find out the different Malayalam fonts in your computer
and complete the table.

Malayalam character styles

Malayalam fonts

mg@g 203 GahiBlo WI@IRIA
Rachana Raghu Malayalam | 26®4m 921302 @200t 0003 - 021

aA088 GIa3H00 EHQRI WHT]QIG
ab@mie Halgea @dEIas @YD - 2Jeim

Chilanka Aruna

Meera A8 ROMMHID EH:AILl WI@IMOD
AA@M) BalDEN MBRIMH @D - @Al ALIMIB.

008 BOMEBUD BBl WA

AGMIMN) Belom MMABRIH MWD - @BEYEM

0083 BIaHdhUd BdhEls WI@IDID
2AMIM He I MOIRIeH MIMD - MYQED

Table 3.3 Different Malayalam fonts

Change the font of the text that we have typed
earlier. What differences do you notice when these
changes are made?

Activity 3.3 Let’s add Hindi language
Input of other languages

After switching over to Malayalam typing,
Malayalam found its place in Unicode technique, other
Indian languages also found their place in it. Now, let’s
examine how we can type in Hindi.

We must make some arrangements in our
computer to type Hindi in it. Refer to Fig.3.5.

The input languages available in our present
system are seen in Input Sources (Fig.3.6). Practice the
following steps to add a new language, for example
Hindi.
¢ Click on Text Entry Settings inthe Desktop panel.
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Fig. 3.5 Text entry settimg window - Step 1

¢ Whenyouclick the : iconinthe Region & language
window, Add Input Source window will appear.

Now click on the more icon, scroll down and
select the Other

Fig. 3.6 Text entry settimg window - Step 2

¢ From the list of languages select Indian and click
Add.

Fig. 3.7 Text entry settimg window - Step 3
Activity 3.4 Let’s type Hindi letters

Change the keyboard layout to Hindi. Try to type
your name on the word processor. Are the keys the same




Can You Type ‘aoma’ In the Computer?

as the Malayalam letters. Prepare a similar table as Table
3.1 on the use of fingers in Hindi layout.

You need some extra symbols in Hindi than in
Malayalam. Don’t forget to include these in the table.

The text given below is a portion from your Hindi
Reader. Type these lines using the font Gargi.

gva ¥ AR G ¥

TH B el -'ﬁ%ﬂtg |
¥ AR RiEr
ffem afer - g &

1. Which among the following keyboard layout helps
us to type Indian languages including Malayalam?

a) Inscript b) ISM
c) C-DAC d) Rachana

2. The following table was prepared by Arun. He
wanted to categorise the fonts used to type
Malayalam & Hindi. He made certain mistakes while
preparing the table. Correct them.

Malayalam Hindi
Gargi Anjali
Meera Samanata
Kalimathi Suruma

3. We have learnt how to add a new language to our
keyboard layout. Suppose we no longer need this
language so added. How can we remove it? Take
the system settings window and write down the
steps to remove a language.
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- Extended activities

1. A diary written by Appu has been saved in the sub folder Diary in the
folder School_Resources for 8th Standard in a jumbled order. Using
the cut and paste tools, arrange the sentences in the correct order. Give
the heading Appu’s Diary.

miag]ed o’ pRicaLIM. A)®EMe OGP 2|AME) FEBSOS 6HT]| W] @M.
@2(@] 10.00 GMIwacd). 6p8dIIge Q9 mu_'.glmm". D0RIND &H)5H07e.

Glcyf Sl aIN6mm HO WSHE MIMIT|@WIe. TYDNICND HMEOM smeEnudaS p-2a70).
600Me @I MO AeWI|@e, emId & QEMar meom ag)geomg.

82020 WbRHOBEIe 2P TOED. HMISOHBEIe WSO ag)G QI WM.

4.30 masnd cndigg)ab oo’ ad)dles wma). Ead])e 8IS TS,

9.30 o0’ @g)ad easowd]. e &om® Moo,

alg) B BF|MOAGIVe aIZMNR HE]60B. oI]O0NN MG

0’ geIwIg. Slwid efandlmoe. ER@I)e ald®e dlay Swid Giojad .
Gra@aSlenn’ Bd|Wans HMaReud H2I@cb amach 0Dy,

2. Type the given poem and give a suitable heading.

@)aMISla)) MmN @OMHEA

261} 2OMMIOWS}HNMMN DO HSIG3

2l GaldOHLINMM) &15lWoms MIBOmGEM,
8 )8l allglajololencsm,

aleNd) 61M6BBUY &) $FlajlSmOnEMESO
ala®) $0UB9)0 BEAIY AUSBTMAIM.

Try to find out the name of the poet with the help of the Internet. For this,
copy the first line and paste it in the address bar of the search engine.




The Amazing World @ your
Fingertips

Let’s know the mysteries of life in the little
chamber

You have studied the lesson Life’s Mysteries in
Little Chambers in your Basic Science textbook, haven’t
you? Do you know that M.]. Schleiden, who discovered
that the body of plants is made up of cells, was a lawyer?
Robert Brown who discovered the nucleus of a cell, was
a doctor. There are cells which are known in the name
of Theodor Schwann who discovered that the animal
body is made up of cells. There are so many interesting
facts like this in connection with the study of cells. Don’t
you feel it good to know more about such facts?

What will we usually do for this? We seek the help
of our teachers. We read books from the library. Along
with these, we can rely on computers and Internet to
collect information. Within seconds, the computer will
gather a lot of information for you on any subject with
the help of Internet. How does it work?
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History of Internet

The advanced research project agency under
American Defence Department designed a
computer network connecting computers at four
centres named ARPANET (Advanced Research
Projects Agency Network) for communication
purpose on 2™ January 1969. This is the beginning
of the Internet. Later it is expanded as the Internet
that we see now by including many institutions
Fig.4.1 Structure of Internet- and countries in this network. India also joined
Diagram in the global network on August 15, 1995.

For more details: https://en. wikipedia.org/wiki/Internet

There are computers in different parts of the world
which store a lot of information on various topics. These
computers are linked to one another and they function
as a network. Those computers which are connected to
these networks can share the information stored in it. If
we connect the computers in our school to this network,
we can also access the information stored in them. But
don’t think that the information on the Internet is fully
dependable and correct.

Computer networks

¢ We have computer networks connecting computers
at different locations around the world for various
kinds of services. There exists mega computer
networks connecting these type of different networks.

¢ This mega computer network spreading all over the
world and the facilities given by it is generally called
Internet.

We get a lot of services through the Internet. Among
them are:

¢ Special facilities to learn lessons using Internet
(E-learning)..

¢ The World Wide Web which helps in the
communication of information (WWW).

Information & Communications Technology-VIII 49



The Amazing World @ your Fingertips

¢ E-mails to make correspondences easy.
¢ Video chat for face to face conversation.

¢ E-governance for effective execution of
Government service and for speedy access of
these services to the public.

¢ E-commerce for buying goods from all over
the world.

¢ Social networking sites that help us to build
friendships to share opinions independantly
between people all over the world.

Further, advanced facilities and techniques are
developed in this field day by day.

Now, let’s examine how information commu-
nication, one of the major facilities on the Internet,
is helpful to us.

Activity 4.1 Searching for information...

Internet cannot be

switched off...!

The working of the
Internet which is world
wide, cannot be stopped
even for a day by
anybody. This is
because, the Internet is
not controlled from a
single centre. Since the
Internet is a network of
thousands of networks
spread all over the
world, even if one
network fails all the
others will remain
unaffected.

You are instructed to find out additional
information, images etc. about the cell from the Internet
in the first chapter Life’s Mysteries in Little Chambers
in your Basic Science textbook (Fig. 4.2). How can we
gather information from the Internet? What are the

prerequisites needed for this?

Fig.4.2 Lessons in Basic Science

1. Our computer should be connected to the Internet.

2. We should know where the information is stored in
the Internet.

3. Weneed a browser software which helps to transfer
information to our computer.
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Information from the
Internet is displayed in
the form of webpages.
The software which make
this available are called
web browser. Firefox
developed by Mozilla
project, Web (epiphany)
by GNOME project,
Chrome (Chromium) by
Google, Internet Explorer
and Edge by Microsoft
etc. are examples of web
browsers.

The Amazing World @ your Fingertips

You might have noticed the link in the textbook
https:/ /en.wikipedia.org/wiki/ Cell_(biology)
given in your textbook. What does it mean? This is
the address of the web page where the information
about cell is stored. It is called the website address.

Find out more information about cells on the
Internet based on the points given below:

¢ Open Firefox web browser in your computer.

¢ Type https://en.wikipedia.org/wiki/Cell_
(biology) in the address bar of the Firefox window
(where we can see ‘Search’ or ‘Enter address”) and
press Enter key.

¢ Now, the information about cells included in
Wikipedia, the online encyclopedia, will be
visible on the monitor (Fig. 4.3).

Let’s note down the required additional
information from this page.

¢ Did you see ‘Languages’ on the panel on the left
side of Wikipedia? Go through the list of
languages given there. You can get information
about cells in all these languages.

Fig.4.3 Wikipedia page about cell
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¢ Click on ‘Malayalam’ in the list of languages.
Now information about cells will appear in
Malayalam.

You are able to visit a website if you get its
web address. We can see web addresses of various
institutions, newspapers, eminent persons etc. if we
go through periodicals, books or other media. For
example, www .kerala.gov.in is the address of the
website that contains official information about
Government of Kerala.

Collect various web addresses of popular
newspapers and institutions and visit their websites.

The first part of the names of the websites which
you visited is www. It is the abbreviated form of
World Wide Web.

World Wide Web

¢ World Wide Web is an important service which
enables information communications through
the Internet.

¢ World Wide Web is a collection of crores of data
stored in computers all around the world.

¢ In World Wide Web, enormous amount of data,
which are useful or not useful, are stored in web
pages as documents, images, videos, sounds etc.
which are mutually linked as well as not linked.

¢ Information from World Wide Web is available
on any computer connected to the Internet.

Activity 4.2 Searching for images...

As instructed in your Basic Science textbook, we
have already found out some additional
information. But, what should we do if we need
different kinds of images of cells?
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Web pages and

website address

We can gather the
required information
from the Internet only if
we know the name in
which it is stored in the
Internet. The information
stored in the Internet has
a specific address. It is
called website address.

The collection of web
pages which contains a
variety of information
which are mutually
linked is called websites.

Website address is also
called URL (Uniform
Resource Locator).

Web portal

There are websites which
act as ways to enter
various websites related
to a particular subject.
These types of sites are
called web portals.
www kerala.gov.in is a
portal through which we
can enter different sites of
the Government of
Kerala.
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For this, we should know the addresses of
websites in which the images of cells are stored, as
we have discussed earlier.

If the website address is not known, Internet
provides some other facilities to find out the
information. These facilities are called Search
Engines.

These search engines help us to find out
without delay exclusively the required
information, pictures etc. from the huge
information repository in World Wide Web.

www.google.com, www.bing.com, www.duck
duckgo.com, www.yahoo.com etc. are some of the
search engines available on the Internet.

Based on the provided stages of activity, collect
different images of cells through search engines and save
in your folder.

¢ Open the web browser and type the address of a
search engine in the address bar (eg.
www.google.com).

¢ While opening Google search engine, a window as
shown in the Fig.4.4 will appear.

Fig.4.4 Google search window

Q7772z777ZzZ77ZZzZZZZZZzZZZZaZgzzzz7z7zZzZzZz
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Wikipedia

Wikipedia is an online encyclopedia. The word
Wikipedia is derived from the terms Wiki and
Encyclopedia. It is a joint venture for making a free
and complete encyclopedia in all languages. This
project works with the support of a voluntary
organisation, Wikimedia Foundation. The content
of Wikipedia is always independent and free of cost.
The articles in the Wikipedia are prepared by
service-minded users all over the world who are
working voluntarily and collaboratively.

Ward Cunningham

An American, named Ward Cunningham is the
person who initiated the concept of Wiki and
developed the software. Using the software Wiki
Wiki Web developed by him in 1994, the website
www.c2.com is established on 25" March 1995. Wiki
means websites which give freedom and facility to
add, delete and modify any information by any user.

Jimmy Wales Since adding information in Wiki is very easy, Wiki
became a fine means for collaborative writing. The
word Wiki is also used to denote software which
provide facility for making notes, articles and other
writings through a collaborative effort.

Jimmy Wales and Larry Sanger started the project
Wikipedia on 15" January 2001. According to 2015
statistics, Wikipedia has editions in more than 280
languages. The English edition was produced under
their leadership. Wikipedia has editions in 20 Indian
languages including Malayalam.

Larry Sanger

¢ Type the word cell (search word) in the search box
of the search engine window. (For getting
information from Internet, it is enough to search by
giving a related search word).

¢ Now, the list of websites which contain the
information about cells will appear (Fig.4.5). To get
images of cells from this, click on Images seen just
below the search box.
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Fig.4.5 Google search list

¢ You have seen various pictures being displayed
while clicking on Images.

¢ You can see cells of different categories (Human,
Plant, Animal, etc.) in the first row (Fig.4.6). You may
click on the category in which the required pictures
are found.

Fig.4.6 Pictures of cells in different categories

Can all the images seen on the Internet be copied
and used?

Some websites give us the right to copy the pictures,
but some others do not. Certain others give us the right
on certain conditions. While we collect pictures to be
used after modification, we should download only those
which offer us copyright.

Google also provides the facility to search for
pictures which do not have copyright.

iz
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¢ If youclick on the search tools below the search box,
usage rights menu will appear as shown in the Fig.
4.7.

Marc Andreessen

Marc Andreessen
developed a graphi-
cal browser which can
handle images and
sound apart from
Fig.4.7 Page in which usage rights are displayed characters in the
Internet. He develo-
ped the browser
Netscape navigator.
He was born in the
year 1971 in Iowa
State in America.

¢ Select ‘Labelled for reuse with modification” from
the list displayed while clicking “usage rights’. Now,
we can access pictures which are free to use or
modify.

¢ Click on the required picture and open it. Then right
click on the mouse and select ‘Save Image As” from
the menu and save the picture for further use.

Activity 4.3 Find the meanings of words

You might have come across various situations
where you had to refer to dictionaries to get the meanings
of words while learning lessons in English and Hindi.

Various online dictionaries in different languages
are available at our fingertips in this era of information
communication technology. We shall familiarise
ourselves with some of the free language dictionaries.

¢ Visit the websites - http://ml.wiktionary.org,
www.olam.in. Note down the difficult words that

Copyright and Copyleft

The information, pictures, movies, sounds etc. available on the Internet are
prepared as a result of the effort of different people. There may be some
restrictions to use it on our own. Some of them have an exclusive right to the
person who developed it based on the copyright law. But some are free for
everyone to use. So while we search and use information from the Internet, we
must be aware whether it is free to use or not. If it is not free, we have to procure
permission from the person or institution concerned to use it.
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Vinton G Cerf

Vinton Cerf, who was
the director of
ARPANET project
(the prototype of the
Internet) is known as
the father of the
Internet. He played
an important role in
developing TCP/IP
(Transmission
Control Protocol/
Internet Protocol)
which is the basic
standard for transfe
rring information on
the Internet. He was
born at New Haven in
America in the year
1943.
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you come across in your English Reader, find their
meanings and write them down. Refer to other
dictionaries and check the meaning.

¢ These websites contain the meanings of not only
English words but also Malayalam words. This is
prepared using the information gathered from
various Malayalam dictionaries. It expands
constantly with the joint effort of a number of
language loving volunteers across the state.

¢ Facilities for translating the meanings of words and
sentences to English and Indian languages like
Malayalam, Hindi, Tamil, Kannada, Telugu etc. and
to foreign languages are available on the Internet.

Can we use these online dictionaries without a
computer or an Internet connection? There are solutions
to this too in this generation of tablets and smart phones.
Offline versions of such dictionaries are now available
as mobile apps in mobile phones and tablets.

Shopping can be done sitting at home

We usually buy rice, vegetables and other things
by going to shops. Do you know that these things can be
bought without going to shops?

There are many commercial sites on the Internet.
The trade using these commercial sites is called Online
Shopping. We can order the required goods by giving
our postal address in these shopping sites. We can pay
the cost of the goods by various methods. The goods
will be delivered to the given address by post/courier
service. Things are very easy, aren’t they? There are
websites which provide such facilities. Find out those
important sites with the help of your teacher.

While using the Internet...!

¢ While visiting websites, get the correct web address
and type it in the browser without mistakes.

¢ Sometimes, errors may occur while typing the web
address. You may be led to wrong websites or may
be cheated since there are people who utilise these
errors for such purposes.
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Mobile Apps for

anything and
everything....

In addition to finding the
meaning of words, we can use
smart phones for many other
day to day activities like
reading the news, performing
banking transactions, finding
routes, reserving tickets,
finding the bus and train
timings etc. Mobile
Applications (App) are now
available to help us. Apps
became popular because they
are easily available in mobile
phones as Internet enabled
services.

Android Play Store of Google,
App Store of Apple, Windows
Phone Store of Microsoft etc.
help to install Apps easily.

While using Mobile Phones....

¢ Using mobile phone while driving will

lead to accidents. If you see someone
using it while driving, remind them of
this danger.

Taking photos and sharing them with an
aim to defame persons or institutions are
offences. Remember that taking photos
without one’s permission is also wrong.

Messages which offer gifts, lottery etc.
have chances of cyber spoofing. Don’t
react to such messages.

Creating false and fake messages which
cause defamation to others or stand
against national interest or generate
rivalry among caste/religion/class is an
offence. Storing such message in mobile
phones, sharing them etc. are also
offences.

Internet of Things (IoT)

Are the electrical equipments at home switched off? Is the valve of the gas
cylinder closed? Is the door closed? At times, you might be worried by such
thoughts. Sometimes, you would be relieved only when you check it going
back home. Now, electronic equipments at home will observe all these things.
They will take care of these things which we have forgotten. Mobile apps and
other facilities are available for these purposes. In short, phones/tabs will become
multipurpose devices in the near future. Internet of Things (IoT) means
observing and controlling equipments connected to the Internet like this.

Cyber Crimes

Cyber world is a term that generally refers to the use of the modern information
communication devices like computer, Internet, mobile phone etc. All activities
done using the information communication devices like mobile phones, computer,
Internet, camera etc. which are against the law or which causes harm or defamation
to persons, institutions, technical facilities etc. are considered as cyber crimes.
You will study more about this in the higher classes.
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Role of Technology in Disaster Management

The flood of 2018 is one of the major disasters that Kerala has ever witnessed.
Can’t early predictions of such disasters mitigate the intensity of the same to
some extent? Computers can be used for analysing the data from weather
forecasting satellite and radars. We can co-ordinate the disaster management
activities using such data.

The information regarding the climatic conditions in different areas is available
in the website of the Indian Meteorological Department. It is responsibility of
Kerala State Disaster Management Authority (KSDMA) to co-ordinate the
disaster management activities in Kerala. More details are available in the
website sdma.kerala.gov.in

Websites for information on climatic changes :

Indian Meteorological Department - imd.gov.in
Kerala Meteorological Department - imdtvm.gov.in
National Disaster Management Athority -ndma.gov.in

National Disaster Management Study Centre - ndma.gov.in

1. The facility that controls the information
repository on the Internet is:

(a) E-Commerce (b) E-Governance

(c) World Wide Web  (c) E-Mail

3. The Internet is:

(@  Network of computers

(b)  World Wide Web

Information & Communications Technology-VIII 59



The Amazing World @ your Fingertips

7

(c)  The mega computer network
spread all over the world and
the facilities provided by it.

(d) Information communication
through computer networks.

4. The facility which helps to find out

i

information, pictures, etc. by
searcing the Internet is:

(@ World Wide Web
(b)  Browser

(0  Search Engine

(d) Wikipedia

5. The trade using the facilities on the
Internet is:

(a) E-mail
(b) E-Governance

(c) E-Commerce

(d) Chat

. The website which can be used

free of cost for collecting
information:

(a) www.wikipedia.org
(b) www.bbc.com
(c) www.cnn.com

(d) www.rose.com

- Extended activities

1. Prepare a note identifying the various services available through the

Internet.

Examine the Malayalam dailies and collect their website addresses

and visit their Internet editions.

Collect images of pyramids in Egypt from the Internet and save them
in your folder.

Collect the details of various types of soil from the Internet, copy them

to the word processor and save them.

Find out the Malayalam meanings of the new words in your English
and Hindi textbooks by using the online dictionaries in the respective

languages.
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Don’t you like computer games? There are a
number of computer games in your computer which
are very helpful for learning and recreation. Are you
familiar with Educational suite GCompris, Potato Guy
etc.? Do you know how these games are prepared?

A few games and animations have been included
in the folder School_Resources/Standard_8/
Games_and_Animations in your computer. Try to play
these games with the help of your teacher. The window
of an interesting game in this folder is given in Fig. 5.1.
This game is prepared using the software Scratch which
is included in your computer.

What should we do to prepare a computer game
like this? You can see the following features in this game.

¢ A car racing track is given in the background and a
car which can be moved along the track is included.

¢ The car can be moved using the Arrow keys on the
keyboard.

¢ Instructions are given to stop the game when the
car moves out of the track.

You can do all these using Scratch software. Let’s
do these activities in the given order.
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Fig. 5.1 Car game screen

Scratch: Scratch is a software used to create
animations, cartoons and games easily.

Stage: Stage is the background appearing when we
open the scratch window. The background will most
often be white. You can change the background colour
as you like.

Sprite: The characters on the background of a Scratch
window are known as Sprite. Usually a cat appears
as a sprite when the Scratch window is opened. The
software provides facilities to make alternations in
sprite.

Activity 5.1 Edit ‘Stage and “Sprite’

Open Scratch software and edit the Sprite adding
a car in it. Include a car racing track as the background.
(You can select the picture of a car racing track and a car
from the Images folder in the School_Resources of your
computer. You can also add pictures drawn using GIMP
Software)

//////////////////////////////////////////////////////////////////////
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I am Sprite.Let me run
through this white
background...

/Sprite buttons

Fig. 5.2 Scratch main window

Order of activity

¢ Open Scratch software.

¢ To add new Sprite: When we open the Scratch
window, usually a cat appears as the Sprite.
Facilities to alter the Sprite and add new pictures
are provided in the Scratch window. For this, you
can use the New Sprite buttons given above the Sprite
List. (See Fig. 5.2 and Table 5.1 for help).

New Sprite

Use

Paint new Sprite

To draw and import New Sprite

Choose new Sprite from File

To include pictures from Costumes Gallery
or computer as sprite.

Get surprise Sprite costumes gallery in computer.

To include pictures as sprite from

Table 5.1 Usage of tools

////////////////////////////////////////////////////////////W
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Delete Sprite : The already included Sprite can be
removed by selecting the delete option from the menu,
after right clicking Sprite.

Oh! Don't
delete me

To change the background/stage : White background
is usually seen when the Scratch window is opened (Fig.
5.2). To change the background, click on Stage in the &',
Scratch window. Now, you can see the tab Costumes in W
the Script area changing to Backgrounds (Fig. 5.3). (b screen region for new costurne
Backgroundl will appear in the Script area when you | &0 thi sprite

duplicate

click on the Background tab. Click on the Edit button to  |idelete

resize this sprite

change the background. Paint Editor window will | rotate this sprite
appear (Fig. 5.3) on the screen.

\

Existing white Button to
background change the Paint Editor window
background /
Import button

Fig. 5.3 Changes made in the Sprite window for changing the background

¢ New background picture can be included using the
Import button in the Paint Editor window.

Open Scratch software according to the instructions
given above and include the background given in Fig.
5.1 (car racing track) and the Sprite (car). Make a sub
folder named Program in your folder. After completing
the activity, save the file in the sub folder.

Activity 5.2 Animate the Sprite

You have noticed a car racing track given as a stage
and a car as a sprite in Fig. 5.1. After the preparation of
the stage and the sprite, let's make the car move using
the keyboard.

//////////////////////////////////////////////////////////////////////
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Fig. 5.4 Block pallet

Extended
Activity

Open “Scratch” Soft-
ware and include an
aquarium as the
background/stage.
Add fish as characters

in the background.
\ J

My Own Computer Game

You may make use of the Block Pallet given in the
Scratch to animate and move the Sprite. To make the
Sprite move using the keyboard, use the Motion, Control
and Sensing tabs in the Block Pallet and follow the
instructions.

Game Instructions (Block Pallet)

Programming instructions in the Scratch Software
are included in the Block Pallet. They are given in
the tabs: Motion, Control, Looks, Sensing, Sound,
Operators, Pen, Variables etc. (Fig. 5.4). Fig. 5.4
contains instructions in the Motion tab. The common
features of the instructions of each tab are given
below.

Motion: To move the Sprites in the Scratch Stage in
different ways.

Control: To control the movements of the Sprites.
Use the instructions in this tab to decide when and
how long the Sprite should move.

Looks: The size, interaction, whether to hide or show
the Sprites etc. are arranged in this tab.

Sensing: To control the movements of the Sprites
according to the instructions given in the keyboard
or the colour of the monitor.

Sound: To control the audio of the Sprites.

Operators: The instructions to solve mathematical
problems and to compare them are included in this
tab.

Pen: To draw figures on the Scratch screen.

Variables: To include variables in the project. For
example, we have to include variables to decide the
score of the game.

The car in the Scratch stage will move forward when
the Up Arrow key is pressed. Press Down Arrow key to
move the car backward, the Right Arrow key to turn it
to right and the Left Arrow key to turn left. To perform

Information & Communications Technology-VIII = §5



My Own Computer Game

these actions, arrange the instructions as given below,
in the Script Area .

To move the Sprite forward using the Up Arrow key,

arrange the necessary code segments in the Block Pallet,

as shown in Fig. 5.5. All these code segments are ( Don't forget to drag

available in the various tabs in the Block Pallet. You

can make use of Table 5.2 for help.

and drop each and every
code segment, OK?

\

Fig. 5.5 Instructions arranged in the window which help us to make the
car moving, using ‘Up Arrow’ key

No. Code Group/ Use
segment Type
. To give instructions using keyboard (to
1 eedE SRSl | Sensing | senge it)
To move the car 5 steps forward. To
2 | Bl EE sl | Motion | change the value of the rounded part
A using the letter “A’.
A To activate a set of codes on certain
occasions. This code segment is used to
3 move the car forward when we use the Up
Control |Arrow key. For this, include first code
segment in part “A” and the second code
segment in part ‘B’.
B
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A It is used to continue the activity till the
game ends. In the given example, the Sprite
moves forward when the Up Arrow key is

4
Clarsil used till the game ends. See how the third

code segment is included in part “A’.
S Control To start the game when we click on Start

Button in the Scratch window.

Table 5.2 Code segments and use

You have prepared the instructions to make the
Sprite move forward using the Up Arrow key as given
in Fig. 5.5. Now, click on the Start & button in the

Scratch window and play the game. You can also make
the car move to both sides and backwards. How can the
codes be prepared for these movements?

Script Segment Use

key down arrow

The car moves backwards when the Down Arrow key
is pressed.

move &) steps

key l=ft arrow | pressed?

The car turns left when the Left Arrow key is pressed. turn @) degrees

kay right arrow | prassad?

The car turns right when the Right Arrow key is

turn degrees
pressed.

Table 5.3 Script segment and use

Prepare the codes with the help of Table 5.3 and
Fig.5.6. Add them to the Scratch file already prepared.

Now, you have prepared the game as shown in Fig.

5.6, haven’tyou? Let's start the game using | 4§ button.
Then complete the Table 5.4.
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)
Ohl
Now the car
can be
. moved to all
sides.

LV_/

Fig.5.6 Window set for the instructions to move the car in all directions.

Sl. No] Code Segment

Group/
Type

Use

To inform the program that the
Down Arrow key is pressed (If we

1 key downamow ' pressed? make changes in the marked part,
we will get the code segments 2, 3
and 4).
2 key rght arrew | pressed?
3 key l=ft arrow | pressed? Sensmg
:
5 To move 5 steps backwards.
6 Motion | To turn the car 5 degree left.
7
. To'brmg back the car to the starting
point, where the game started.
9 [ To set the direction of the car towards
-
right.
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To give one second pause between two
actions.

11

To hide the car temporarily.

12

- I

To make the car visible again.

Table 5.4 Different code segments and their uses

4 o)
Extended activity

Open the Scratch
Software and include
an aquarium as the
stage/background.
Include fish as
characters on the stage
and make them move
using the keys on the

keyboard.
=y e )

Activity 5.3 When the car moves out of the track

You have prepared the code segments for moving
the car through the track with the help of the arrow keys
, haven’t you? Add a segment to end the game, when
the car moves out of the track. Bring the car back to the
starting point.

You can use the techniques like Colour Sensing,
Show, Hide etc. in the Sprite software. See the
instructions arranged in Fig. 5.7. Add these instructions
to the project prepared earlier and activate it. You can
see that the game ends when the car runs out of the track
and goes back to the starting point.

Scratch Online

The animations, game and other resources prepared
using the Scratch software can be uploaded. You can
also view the resources shared by other people. The
website https://scratch.mit.edu and the online group
scratched.gse.harvard.edu will help you to upload your
files. This online group started in 2009 is known as
ScratchEd. You will share the animations and games
you have prepared with the help of these sites, won’'t
you?

Colour Sensing

Now, you are familiar with the instructions given to help the program to identify
the pressings of the key. The instructions to identify the colours on the screen
are also available in the Scratch software. These instructions are known as Colour
Sensing code Segments. The code segment to recognize a colour touching
another colour is shown in Fig. 5.7. This code can recognize when the colour of
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the central part of the car touches the road outside the track. It is possible in the
following way

¢

Drag the Colour Sensing Instruction into the section needed in the game
code.

color is touching

A B

First, click on the first (A) cell. Now, the mouse pointer will become the
colour picking tool. Then, click on the black central part of the car. You can
see that the “A’ cell has become black. Click on the ‘B’ cell and then click on
the colour of cell out of track. The game ends when the colour of “A” cell
touches the colour of the ‘B’ cell. Play the game.

wait pf secs

show

gotux:my:

point in direction m

Fig. 5.7 An example of colour sensing segment =

Activity 5.4 Changing costumes

you

You have prepared the car game, haven’t you? Did
notice that the running car and the static car are of

the same shape? Can the running car be made attractive

////////////////////////////////////////////////////////////////////y
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by making slight changes in its shape? For this, you have
to create or include a new car using the Costumes tab.
The steps to create Costumes are given below.

¢ Select sprite (car) and click on the tab Costumes.

¢ The car present under the Costumes tab will be seen
in the name car (Fig. 5.8).

¢ DPress the Copy button shown below the car. A copy
will be available under the name Car1. (The second
car in Fig.5.8 is created in this way).

¢ Press the Edit button below to make changes in Car1.
The Paint Editor window will appear. Changes can
be made by using the tools in the editor. (See the
three grey bubbles in Paint Editor in Fig. 5.8.) Then
click on OK button.

Fig. 5.8 Paint Editor window

Steps to include the

Present code segment | Edited code segment changed Sprite into the
program are given below.

¢ Thecode segment used to
forever make the car move

if key UYparow | pressed?

forward is shown in the
tirst cell in Fig. 5.5. You
= may change this as in the
second column and add

move &) steps

Fig. 5.5 Changing of a code segment itin the existing program.

iz
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Now, play the game. You can see cars in different
shapes when in motion and stationary.

You can make more changes in the program of this
game. Scoring, using more than one car etc. are some of
the possibilities. Try it.

Not only games, but all the software you use in
your computer are developed with the help of different
programming languages. Writer, Gimp, Calc etc. are
developed using different programming languages.
Don’t you want to prepare games and animations like
these? The car game we have prepared can be a
beginning.

Programming language

All the softwares including the ‘games’ in the computer are created with the
help of different programming languages. Python, C++ etc. are examples of
programming languages. But these languages are not easy to use, because the
instructions should be learnt byheart. If we can make a program without learning
the instructions, how easy it would it be! This is also possible. Visual
programming language helps us to do this. Scratch is one such programming
language.

1. Which of the given instructions can be used to turn
the car 30 degrees right?
: s
: 9

2. How can the background/stage of Scratch software

be changed?

a) Select Sprite and click on Backgrounds tab to
change the stage.

b) Select Stage and click on Backgrounds tab to
change the stage.

c) Select Sprite and click on Costumes tab to
change the stage.

d) Select Stage and click on Costumes tab to
change the stage.
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4.

Which one of the following tab includes instructions
to move the Sprite?

a) Motion b) Control

c) Sensing d) Looks

How can you change the Sprite in ‘Scratch’ software?
a) Select Sprite and click on Backgrounds tab

b) Select ‘Stage” and click on Backgrounds tab

c) Select Sprite and click on Costume tab.

d) Select ‘Stage’ and click on Costume tab.

Follow-up activities

* Complete the table given below.

SL Code Group/
Use
No. Segment Type
1
2 switch to costume costumeZ
3 wait il secs
4 go to = E ¥:

¢

When Scratch software is opened you can see the
cat (Sprite). Prepare instructions to move the cat to
all the four directions.

Include the pictures like Ballerina-a, Ballerina-b as
Costume Sprite. You can get these pictures from the
People section of Scratch Costumes. Now, prepare
and activate the instructions to get ‘Ballerina-a’ when
the key “A’ is pressed and “Ballerina-b” when the key
‘B’ is pressed.

Some codes are there in the table given in the next
page. Complete the table.

//////////////////////////////////////////////////////////////////////
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Scratch instructions Similar codes

If (Down arrow key is pressed)
Backwards (5 steps)

move B steps

pressed?

turn t) degrees

7 key right arro

turn degrees

- Extended activities

1. Select pictures from Costumes Gallery of Scratch software. Using these
pictures, prepare an animation in which a bat flies in front of a house.

Prepare the animation in which an aeroplane flies in the sky.

Prepare the animation of a person dancing. Select and use pictures from
Sprite Gallery of Scratch software.

Include another car in the car game that you have already prepared.
The new car should function when the keys W, A, S, D are used.
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Let's know about cyber safety

There is absolutely no need to mention the advantages of Internet and Social
Networking sites. We have embraced their potential for communication,
entertainment and information seeking.

But over the period, it is seen that a lot of teenagers are being harassed and fall
prey to the abuse of Social Media. You can easily prevent yourself from being
avictim, if you take a few precautionary measures while being online.

» How Social Networking sites can be dangerous

e Sharing and posting too much of personal information such as phone
number, address, location, photos, etc., can be misused.

» Trusting strangers believing their profile to be true can be dangerous, as they
may not be the same as stated.

» Snapshots of chats, photos, videos, etc., are saved and will be used for
blackmailing and threatening.

» Being cyber bullied by posting negative, derogatory comments, posts, photos,
etc. to tarnish one's image.

* Lots of predators and adult criminals are lurking online to trap children.

» Tips for safe Social Networking

» Always keep your personal information strictly personal.

 Customize your privacy settings so that others can see only the basic information.

 Just know about and manage your friends. Don’t trust all the online friends.

» Let your friends know that you are uncomfortable if they post something
inappropriate about you.

Do not publish any information that reveals your identity.

* Always use strong passwords. Don’t share them with others.

» Never share your pictures, photographs, email accounts, etc., with anyone.

» Keep your personal messages strictly personal. Once posted they are published
for ever.

* Ifeverthreatened or bullied seek the help of parents/teachers.

Helpline Phone Numbers

Crime Stopper: 1090
Cyber Cell (Tvm): 9497975998
—] Control Room: 100 —
Child Helpline: 1098 / 1517
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